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Warranty and Liability
Note The Application Examples are not binding and do not claim to be complete

regarding the circuits shown, equipping and any eventuality. The Application
Examples do not represent customer-specific solutions. They are only intended
to provide support for typical applications. You are responsible for ensuring that
the described products are used correctly. These application examples do not
relieve you of the responsibility to use safe practices in application, installation,
operation and maintenance. When using these Application Examples, you
recognize that we cannot be made liable for any damage/claims beyond the
liability clause described. We reserve the right to make changes to these
Application Examples at any time without prior notice.
If there are any deviations between the recommendations provided in these
Application Examples and other Siemens publications – e.g. Catalogs – the
contents of the other documents have priority.

We do not accept any liability for the information contained in this document.
Any claims against us – based on whatever legal reason – resulting from the use
of the examples, information, programs, engineering and performance data etc.,
described in this Application Example shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of
a deficiency or breach of a condition which goes to the root of the contract
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial
contractual obligation are, however, limited to the foreseeable damage, typical for
the type of contract, except in the event of intent or gross negligence or injury to
life, body or health. The above provisions do not imply a change of the burden of
proof to your detriment.
Any form of duplication or distribution of these Application Examples or excerpts
hereof is prohibited without the expressed consent of the Siemens AG.

Security
infor-

mation

Siemens provides products and solutions with industrial security functions that
support the secure operation of plants, solutions, machines, equipment and/or
networks. They are important components in a holistic industrial security
concept. With this in mind, Siemens’ products and solutions undergo continuous
development. Siemens recommends strongly that you regularly check for
product updates.

For the secure operation of Siemens products and solutions, it is necessary to
take suitable preventive action (e.g. cell protection concept) and integrate each
component into a holistic, state-of-the-art industrial security concept.  Third-party
products that may be in use should also be considered.  For more information
about industrial security, visit http://www.siemens.com/industrialsecurity.

To stay informed about product updates as they occur, sign up for a product-
specific newsletter. For more information, visit
http://support.industry.siemens.com.

http://www.siemens.com/industrialsecurity
http://support.industry.siemens.com/
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1 Task and solution
1.1 Task

The standardization of automation engineering for processing plants, such as in
the chemical industry, is a major challenge. Different process steps and
procedures, different equipment and flexibility in the production make the task even
more difficult.
This includes the plant structure according to the ISA-106. This specifies the lower
four levels, i.e. plant area, unit, equipment and device. A plant always consists of
units. The units contain standardized equipment modules.

1.2 Solution

1.2.1 Distillation column plant section

The unit template "Distillation column" is a template that comprises all typical
components of a distillation column, their open- and closed-loop control, the
necessary logic and the visualization.

Figure 1-1: A distillation column as part of a process plant

The associated example project is structured in such a way that it enables the
direct transfer of predefined elements into an existing PCS 7 project.
The Advanced Process Library (APL) is used with a multivariable regulation
concept for the user program. The multivariable controller enables control of
the distillation column to maintain the required product quality constant.
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The plant section distillation column consists of multiple individual process
components, such as devices, actuators and sensors. The closed loop control
is the link between all the components of a distillation column and thus an essential
component of an automation system.
During configuration, a variety of conditions need to be considered (e.g. interlocks,
control structures), which require a high detailed knowledge of the process plant
and a high detailed knowledge and experience with PCS 7.

1.2.2 Description of the complete solution

The quality of material separation is measured by the purity of the separation
products, i.e. after concentration by low and high boilers in the head and bottom
outlet. The measuring of these concentrations by means of online analyzers is so
complex, that it is omitted in most plants. Thermodynamic correlations are formed
in the phase equilibrium (between vapor and liquid) at the individual trays of the
column, so there is also a correlation between the concentrations and
temperatures. The easily measurable temperatures are used as substitute control
variables. This has the additional advantage that the relationship between the
temperatures and control interventions can linearize more easily than the
connection between the concentrations.
The Unit Template "Distillation column" provides an example of a process plant.
The example project has been implemented as a PCS 7 multiproject as follows:
• One project for the automation system (AS) and one project for the operator
station (OS) are respectively contained in the component view.
• A hierarchy folder has been set up in the technical hierarchy for each equipment
module.
The AS project contains all open- and closed-loop control functions in the form of
CFC (Continuous Function Chart) charts. The PCS 7 project also contains an
example simulation of a distillation column (random packings or packed columns)
for distilling isopropanol (low boilers) and butanol (high boiler).
The AS project was created using the APL (Advanced Process Library), which
among other things also includes a model predictive multivariable controller. The
multivariable controller is the core element of the control strategy and takes over
the regulation of the head and bottom temperature in the distillation column.
Further closed-loop controllers are connected subordinately to the multivariable
controller.
The process screens contain the most important parameters (KPI: Key
Performance Indicators) of the distillation column, as well as all detailed information
on the individual components and components for operation and monitoring.
For an optimized process control and monitoring, two additional process screens
have been created with Advanced Process Graphics (APG). They are clear and
reduced to the essentials. The process images focus on how to consider the
relevant process screens within the work areas.
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Delimitation
The following special cases are not covered by the Unit Template "Distillation
column":

Multicomponent distillation, i.e. columns with additional side draws

Columns with gaseous head products that require a different pressure control
structure

 Vacuum columns with a special pressure control structure
 Strippers, i.e. columns without the reinforcement part
 Columns that have no representative temperature as a control variable

Required knowledge
Fundamental knowledge of the following specialist fields is a prerequisite:
 Engineering with SIMATIC PCS 7 and the APL library
 Knowledge of control technology
 Basic knowledge of process technology

1.2.3 Core functionality

The individual components of the column are described in the following section.
It is operated in the PCS 7 Operator Station.
The visualization interface of the Unit Template "Distillation column" is composed
of the following pictures:
 Plant overview picture for orientation and navigation (Level 1)
 Process screen for operation and monitoring (Level 2)
 Detailed process screen in R&I representation with all components (Level 3)

Figure 1-2: Visualization interface
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Plant overview picture
The overview picture consists of the following objects:
 Spider graph representation of typical distillation column parameters and

temperatures
 Bar graph representation of the feed into the column and removal of the two

products from low boilers and high boilers
Figure 1-3: Level 1 plant overview picture

Process screen
The process screen shows the most important process values for monitoring and
operating the distillation column. From the associated faceplate, you can get further
detailed information about each displayed value and make changes. The trend
display shows the actual, target and control variables of the multivariable controller.
Figure 1-4: Level 2 process screen
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Detailed process screen
The process screen shows a schematic representation of the block icons of the
sensors and actuators. The process screen also includes an overview of the Key
Performance Indicators. The process screen gives the operator an overview of
the entire plant and enables him to take the necessary operator actions.

1.2.4 Description of the individual functions

Figure 1-5: Level 3 detailed process screen

1

3
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The process screen of the distillation column consists of the following main parts:
1. Pressure control
2. Feed
3. Bottom temperature (“Vapor”)
4. Distillation column
5. Capacitor with reflux ("Reflux")
6. Removal of the head product ("Low boiler")
7. Removal of the bottom product ("High boiler")

(1) Pressure control
The pressure at the column head is determined by the temperature of the removed
gaseous mixture.

(2) Feed
The mixture flows to the distillation column via the feed.
A PID controller regulates the feed (control variable) to the configured setpoint.
The actual value flows as a disturbance variable to the higher-level multivariable
controller.
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 (3) Evaporator ("Vapor")
The evaporator removes the liquid mixture from the column bottom and heats it
until the components evaporate. The gaseous mixture is then returned back into
the distillation column.
The vapor (control variable) used for heating the evaporator is regulated by a valve
(manipulated variable) with a PID controller, which receives the setpoint from the
multivariable controller.

(4) Distillation column
The distillation column is controlled by means of a multivariable controller.
The head and bottom temperature (control variables) are recorded and regulated
by means of the heating vapor amount or the condensate reflux (manipulated
variables). The two manipulated variables are used as setpoint entries for lower-
level PID controllers.

(5) Capacitor with reflux ("Reflux")
The capacitor removes the gaseous mixture from the head of the column and cools
it off until both substances (low boilers and high boilers) condense. The liquid
mixture is partially recirculated to the distillation column. The capacitor also
includes a tank in which the liquid mixture is stored temporarily in order to enable
reflux rate control.
The top pressure of the distillation column (control variable) is controlled via the
cooling water flow rate (manipulated variable) by means of a PID controller.
The setpoint value specification is implemented by the operator.
The reflux (control variable) is controlled by means of a PID controller via a valve
(manipulated variable). The setpoint is selected from the multivariable controller
of the distillation column.

(6) Removal of the head product ("Low boiler")
The amount of outflowing head product depends on the fill level of the capacitor
and cannot be specified. When the entire distillation column has a stable operating
point, the amount of head product to be removed is composed of the following
components:
 Concentration of the low boiler in the feed mixture
 Feed amount of the distillation column

The fill level in the condensate tank (control variable) is controlled by a PID
controller via a valve (manipulated variable). The setpoint value specification is
implemented by the operator.

(7) Removal of the bottom product ("High boiler")
The amount of bottom product to be heated depends on the bottom fill level and
cannot be specified. When the entire distillation column has a stable operating
point, the amount of bottom product to be removed is composed of the following
components:
 Concentration of high boiler in the feed mixture
 Feed amount of the distillation column

The fill level in the condensate tank (control variable) is controlled by a PID
controller via a valve (manipulated variable). The setpoint value specification is
implemented by the operator.
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Additional functions
 Temperature and pressure reading

The distillation column gives 6 temperature readings and 2 pressure readings:
– Temperature at the distillation column head
– Pressure at the distillation column head
– Temperature for head temperature control
– Temperature above the feed
– Temperature below the feed
– Temperature for bottom temperature control
– Temperature at the distillation column bottom
– Pressure at the distillation column bottom

 Concentration specification
With regard to the feed, the concentration of the low boiler can be specified in
relation to the high boiler. This concentration ratio is an unrecorded
disturbance variable for the process.

 Operating point
A sequential function chart (SFC) for the ramp up of the distillation column in
the operating point.

Parameters (KPI = Key Performance Indicator)
The following key performance indicators are measured or calculated:
 Pressure drop = pressure at the bottom of the column – pressure at the head

of the column
 Relative energy consumption = amount of vapor / production volume of head

product
 Reflux ratio: Reflux / discharge of head product

1.2.5 Control concept

A multivariable controller (MPC) is used for controlling the distillation process.
This controls the head and bottom temperature (also refer to Chapter Temperature
characteristic). These control variables are detected by the temperature measuring
points of the head and bottom temperatures. The manipulated variables of the
multivariable controller are used as a setpoint for underlying PID controllers.
The two level controls of the distillation column are provided with PID controllers
and work independently.
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1.2.6 PI process screen

The following figure shows the individual elements of a distillation column in
a piping and instrument flow chart.
Figure 1-6
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1.3 Hardware and software components

1.3.1 Validity

This application is valid from SIMATIC PCS 7 V8.1 SP1.

CAUTION The engineering in CFC requires CFC V8.1 SP1 Update 3. This can be obtained
from the Support Request. The operator station can be started and operated
without the CFC update.

1.3.2 Components used

Hardware components
Table 1-1

Component Note

SIMATIC PCS 7 ES/OS IPC647D For the PCS 7 V8.1 SP1 example project

Note In case of different hardware, please take heed of the minimum requirements for
installing the software components. The minimum requirements can be found in
the Read Me file of the PCS 7.

Software components
Table 1-2

Component Note
S7 PLCSIM The license does not form part of the SIMATIC PCS 7

ES/OS
APG library V8.1 The license does not form part of the SIMATIC PCS 7

Example files and projects
The following list contains all the files and projects used in this example.
Table 1-3

Component Note
48418663_DistillColumn_PROJ_PCS7V811.zip PCS 7 V8.1 SP1 example project
48418663_DistillColumn_DOC_en.pdf This document

Note The download contains elements that require a license. Use in your configuration
environment or in the process mode obligates you to purchase the appropriate
PCS 7 Advanced Process Graphics (APG) license.

The ordering information can be found in the Entry ID 104206476.

https://support.industry.siemens.com/my/ww/en/requests/#createRequest
https://support.industry.siemens.com/cs/ww/en/view/104206476
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2 Basics
2.1 Process engineering

2.1.1 Distillation column (rectification column)

During distillation, a multi-component mixture is divided into at least two streams.
In this process, the different boiling temperatures of the components are used. The
mixture (liquid) is fed into the column through an inlet at the bottom of the column
and vaporized.
The gas mixture rises to the top of the column, where the mixture cools and
condenses again. The component with a high boiling point (high boiler)
accumulates at the base of the column (bottom) and can be removed.
The component with a low boiling point (low boiler) accumulates at the head of the
column and can be removed from there. The balance between the high boiling and
the low boiling constituents shifts along the entire column.
During the rectification process, the gas mixture is fed back again into the column
via a reflux by means of a a cooler. Thus the reflux drips in countercurrent to the
high rising vapor down numerous shelves where it evaporates again. The
rectification process therefore constitutes an extension of the distillation process
or a series connection of several distillation steps.
Figure 2-1
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2.1.2 Temperature characteristic

The quality of material separation is measured by the purity of the separation
products, i.e. after concentration by low and high boilers in the head and bottom
outlet. The measuring of these concentrations by means of online analyzers is so
complex, that it is omitted in most plants. Thermodynamic correlations are formed
in the phase equilibrium (between vapor and liquid) at the individual trays of the
column, so there is also a correlation between the concentrations and
temperatures.
The easily measurable temperatures are used as substitute control variables.
This has the additional advantage that the relationship between these
temperatures and control interventions can linearize more easily than the
connection with the concentrations.
In the process design of the column, an S-shaped, vertical temperature profile is
fixed inside the column to achieve the desired concentration profile and therefore
the desired purity of the products. Two representative temperature measuring
points are placed in the rectifying and output section of the column for control.
The following points should be noted:
 In order for the measuring points to react properly to the changes inside the

column (e.g. to changes in the feed rate or the composition of the feed), they
should be located in the part of the S-shaped profile where a significant base-
to-base temperature difference prevails.

 The dead times of the temperature control increase with the distance from the
measurement points to the head and bottom.

The following figure shows the S-shaped temperature profile of a distillation column
for two different temperature distributions.
Figure 2-2

Temperature
curve

Representative
temperature measuring
points
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2.2 Automation

2.2.1 The "unit" concept

The term "unit" represents a plant section, device, machines in a process plant
together with the sensors, actuators and automation systems required in this
combination of components. This unit serves as a template for identical or similar
devices in terms of standardization.
A subset of the process plant sections are so-called "package units". For example,
package units could be refrigeration systems, vacuum systems and packaging
machines. In this case, the manufacturer of the mechanical or technical device
includes automation, specially tailored for this device, and which is mounted locally
on special hardware on the device. The package unit is integrated as a whole into
a process control system. No detailed knowledge of the package unit's automation
system is required in order to plan the control system.
In contrast to the package units, automation solutions for process plants are
unified, pre-made and created in the unit concept in form of templates that are
not bound to specific hardware or only partially so. Therefore, the templates must
be only adapted to the existing hardware and the special requirements.
This significantly decreases the engineering effort required for several similar
automation tasks.

Unit Template
In a Unit Template, CMs (control modules) are combined into an automation
function. All CM relevant blocks are connected in a CFC. A uniform naming
convention was used for names.
A unit template also contains a CFC with economic and process indicators
(KPI parameters), a CFC for monitoring the operating time and CFC charts for
simulation.
The unit template is summarized in a hierarchy folder and can be integrated into
existing projects.
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2.2.2 PCS Engineering with control modules

A CMT (Control Module Type) in a process control system is a unified template for
creating signal flow charts, which occur more than once in the automation system
of a plant. The signal flow charts (CFC: Continuous Function Chart) for many
similar measuring points are produced by forming instances of a CMT and have to
be subsequently configured and connected with concrete measured/manipulated
variables. The parameterization and interconnection of the CM can be automated
by means of a mass data engineering tool.
A unit template in SIMATIC PCS 7 covers all the functions required for the
automation of a plant section:
 CFC charts (instances of CMT)
 SFC charts
 OS pictures

All functions are combined in a hierarchy folder of the SIMATIC Manager plant
view.

2.2.3 Key Performance Indicators

Key Performance Indicators are economic or procedural parameters that describe
the production progress, the degree of fulfillment of certain requirements, or the
quality of a plant.

2.2.4 MPC controller

The MPC controller is a model predictive multivariable controller (Model Predictive
Control) used for the control of complex linear systems.
If there are several manipulated and control variables influencing each other in
a plant section, a multivariable controller leads to significantly better control results.
The aim of the closed loop control is to run each control variable to the individual
setpoint regardless of the other control variables. This reduces the probability that
an intervention on a manipulated variable acts not only on a control variable but
also affects other control variables.
A model predictive multivariable controller additionally uses a complete
mathematical description of the controlled system. This description allows the
controller to calculate the process behavior over a defined period of time
("prediction horizon") without controller intervention. An optimization method allows
the most efficient setting strategy to be selected and the planned optimal course
to be calculated. There are several possibilities in the formulation of the
optimization problem. Besides the future control deviation and the adjustment
effort, even limit values for control variables and other economic objectives can
be incorporated in the performance criterion.
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2.2.5 Linearization

Many components in industrial plants have nonlinear characteristic curves.
The characteristic curve of many valves does not give a flow rate of 50% at 50%
of the maximum value. The greater the deviation of the flow rate from the linear
characteristic is, the worse the control result of a linear regulator is. Since the
planning of a nonlinear controller is more difficult than that of a linear controller,
the characteristics are usually linearized.

Linearization in the operating point
In the linearization at the operating point, it is not the entire characteristic curve
what gets considered, but rather the part of the characteristic curve that lies at
the intended operating point and which is required during normal operation. In
the operating point of the characteristic curve, a tangent is laid and the deviation
between the tangent and the characteristic curve is considered.
Figure 2-3
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Lower limit Upper limit

Linear characteristic

Valve
characterisitc
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absolute press.

The tangent at the operating point helps reducing the deviations between the
actual non-linear characteristic curve and the adopted tangent to such an extent
that in most cases, no adjustments to the controller parameters must be made.
If a controller is designed for the working range between the lower and upper limits
(working range), the controller applies only for this range. If several operating
points of a characteristic curve are required, a controller can be designed for each
operating point and the controller parameters can be then adapted to the
respective operating point depending on the process value.
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Linearization with compensation function
The linearization with a compensation function is typically used when the working
range takes up most of the characteristic curve. In this linearization, a polynomial is
generated, which gives a linear function when multiplied by the valve characteristic
curve. The following figure shows how the compensation function is determined
mathematically or graphically.
Figure 2-4
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3 Structure and principle of operation
3.1 Project structure

3.1.1 CFC naming convention

A uniform naming convention was used for identifying the control modules,
whereby the function has been named according to the European standard
EN 62424. The following figure shows how a label is composed.
Figure 3-1

FIC_Reflux

Function
F = flow (first letter)
I = indication (subsequent letter)
C = control (subsequent letter)

Name

The following table provides all the letters used in the application and their
meanings:
Table 3-1

First letter

Letter Meaning

F Flow
L Level
N Motor
P Pressure
Q Amount, quantity
S Speed (velocity, rotational speed, frequency)
T Temperature
Y Control valve

Subsequent letter
C Control
F Fraction
I Indication
S Binary control function or switching function (not safety-

oriented) ("switching")
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3.1.2 Technological view

The Unit Template "distillation column" is designed as a multiproject and structured
in the technological view of an OS and AS project.
All process screens can be found in the hierarchy folder of the OS project whereas
the automation program is stored in the AS project in a structured manner.
The following figure shows the structure in the plant view.
Figure 3-2
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3.2 Equipment modules and control modules

The unit template "Distillation column" consists of pre-made equipment modules
and additional CFC, e.g. for process simulation. In a PCS 7 project, all measuring
points including the measuring points of the equipment modules are based on
control module types from the master data library. You will find the application
description "Equipment Modules for PCS 7 using the example of the Chemical
Industry" and the example projects with the individual equipment modules and
control module types under the entry ID: 53843373.
This Application Example contains the following components:
 Head pressure control
 Inflow "Feed"
 Evaporator "Heating"
 Capacitor with reflux "Reflux"
 Removal of the head product "HeadLevel"
 Removal of the bottom product "Bottom Level"
 Distillation
 Overarching process simulation "Process"
 Step sequencer (SFC) for starting up the distillation column
 Process parameters "KPI"
 Maintenance characteristics "Maintenance"
 Optimized process control with APG

In the following chapters you will find the setup of the specific equipment modules
as well as the extension and modifications made vis-à-vis the original equipment
modules and control module types.

Note All necessary descriptions, configurations and procedures pertaining to the
reference versions can be found in the documentation under the entry ID:
53843373. You will find the information on the specific equipment modules in
Chapter 5 "Equipment Modules" and on the control module types in Chapter 4
"Control Module".

https://support.industry.siemens.com/cs/en/en/view/53843373
https://support.industry.siemens.com/cs/en/en/view/53843373
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3.3 Head pressure control "Pressure"

The amount of mixture removed from the column head is determined with the
pressure control.

Note For more demanding applications where fluctuations or other unpleasant
properties of the actuator can be compensated (e.g. nonlinear valve
characteristic curve), the equipment module "Temperature-Flow-Cascade" can
be used for pressure control.

Structure
The pressure is controlled by means of a PID controller with a fixed setpoint value
specification by the step sequencer. During process mode, the setpoint can be set
by the operator in the defined area.
The following table provides an overview of the CM and the selected variants.

Table 3-2

CM CMT Variant Description

PIC_ColuHead "Ctrl" Ctrl_Std Head pressure control
YC_ColuHead "ValAn" ValAn_Std Control valve for the cooling water going

to the heat exchanger

In the following figure, the structure with the cross-chart interconnection is depicted
in simplified form.
Figure 3-3
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"Sim_ColuHead" simulation
In the simulation chart, the process value is simulated by the setpoint change
(delay time and process gain).
Figure 3-4

1 2 3

1. Lag time of 10 seconds, which is caused by the inertia of the actuator as well
as by the time constant of the flow sensor.
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2. The gain factor for the simulation of the process gain.
3. Connecting noise to the manipulated variable

Parameter assignment

PIC_ColuHead
The instance has the following parameterization.
Table 3-3

Block Connection Value Use

PV_Scale HiScale 2 Process value upper limit
PV_Unit In 1137 Process value unit in bar
C Gain 6 Controller gain
C TI 3.5 Controller lag
C SP_InHiLim 1.5 Upper limit of the internal setpoint
C SP_InLoLim 0.8 Lower limit of the internal setpoint
C PV_AH_Lim 1.8 Alarm upper limit for the process value
C PV_WH_LIM 1.5 Warning upper limit for the process value
C PV_WL_Lim 0.8 Warning lower limit for the process value
C PV_AL_Lim 0.5 Alarm lower limit for the process value
C PV_Hyst 0.2 Hysteresis for the limit values

C

PV_AH_En
PV_WH_En
PV_WL_En
PV_AL_En

Activation of the alarm and warning limit
monitoring

C MV
Interconnection for the simulation
(Sim_ColuHead\Lag_ColuHead.In)

C PV_Out
Interconnection for
(Distillation\\KPI\pBotMinus_pHead.In2)

to_Actor_Slave Out
Interconnection for the valve
(YC_ColuHead\from_Ctrl.In)

from_Actor_Slave In
Interconnection for the valve
(YC_ColuHead\to_Ctrl.Out)

PV SimPV_In

Interconnection for the simulated
process value
(Sim_ColuHead\Noise_ColuHead.Noise)

YC_ColuHead
The instance has the following parameterization.
Table 3-4

Block Connection Value Use

from_Ctrl In
Interconnection for the controller
(FIC_ColuHead\to_Actor_Slave.Out)

to_Ctrl Out
Interconnection for the controller
(FIC_ColuHead\from_Actor_Slave.In)
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3.4 Inflow "Feed"

The mixture to be separated is fed to the distillation column via the inlet in
a constant flow. The flow volume acts as a disturbance on the multivariable
controller.

Structure
Inflow control is performed by means of a standard PID controller with a setpoint
value specification by the step sequencer. During process mode, the setpoint can
be set by the operator in the defined area.
The following table provides an overview of the CM and the selected variants.

Table 3-5

CM CMT Variant Description

FIC_Feed "Ctrl" Ctrl_Std Flow controller for the input material mixture
YC_Feed "ValAn" ValAn_Std Analog control valve for the input material

mixture

In the following figure, the structure with the cross-chart interconnection is depicted
in simplified form.
Figure 3-5
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"Sim_Feed" simulation
The mixture feed is simulated in the simulation chart.
Figure 3-6

1 2

1. Lag time of 2 seconds, which is caused by the inertia of the actuator as well as
by the time constant of the flow sensor.

2. The gain factor for the simulation of the process gain.
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Parameter assignment

FIC_Feed
The instance has the following parameterization.
Table 3-6

Block Connection Value Use

PV_Unit In 1352 Unit of the process value in L/min
C TI 2.0 Controller lag
C SP_InHiLim 25.0 Upper limit of the internal setpoint
C SP_InLoLim 15.0 Lower limit of the internal setpoint
C PV_AH_Lim 30 Alarm upper limit for the process value
C PV_WH_LIM 25 Warning upper limit for the process value
C PV_WL_Lim 0 Warning lower limit for the process value
C PV_AL_Lim 30 Alarm lower limit for the process value

C

PV_AH_En
PV_WH_En
PV_WL_En
PV_AL_En

Activation of the alarm and warning limit
monitoring

C MV
Interconnection for the simulation
(Sim_Feed\Lag_Feed.In)

C PV_Out

Interconnection for
(Distillation\\TIC_DistBottom\MPC.DV1)
(Process\\Sim_ProcModel\F_Norm.In1)
(Distillation\\KPI\MassBalance.In1)

to_Actor_Slave Out
Interconnection for the valve
(YC_Feed\from_Ctrl.In)

from_Actor_Slave In
Interconnection for the valve
(YC_Feed\to_Ctrl.Out)

PV SimPV_In

Interconnection for the simulated process
value
(Sim_Feed\Gain_Feed.Out)

YC_Feed
The instance has the following parameterization.
Table 3-7

Block Connection Value Use

from_Ctrl In
Interconnection for the controller
(FIC_Feed\to_Actor_Slave.Out)

to_Ctrl Out
Interconnection for the controller
(FIC_Catalyst\from_Actor_Slave.In)
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3.5 Evaporator "Heating"

The temperature of the column is determined by pumping the mixture at the
column bottom through the external heat exchanger.

Structure
Flow control is performed by means of a standard PID controller and an external
setpoint from the multivariable controller "TIC_DistBottom". The following table
gives you an overview of the CM and the selected variants.

Table 3-8

CM CMT Variant Description

FIC_Vapor "Ctrl" Ctrl_Std
Activated option "Opt_IF_Master"

Vapor flow control

YC_Vapor "ValAn" ValAn_Std Control valve for the vapor feed to the
heat exchanger

In the following figure, the structure with the cross-chart interconnection is depicted
in simplified form.
Figure 3-7
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"Sim_Vapor" simulation
In the simulation chart, the process value is simulated by the setpoint change
(delay time and process gain).
Figure 3-8

1 2

1. Lag time of 5 seconds, which is caused by the inertia of the actuator as well as
by the time constant of the flow sensor.

2. The gain factor for the simulation of the process gain.
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Parameter assignment

FIC_Vapor
The instance has the following parameterization.
Table 3-9

Block Connection Value Use

PV_Scale HiScale 10 Process value upper limit
PV_Unit In 1352 Unit of the process value in L/min
C Gain 10 Controller gain
C TI 2.5 Controller lag
C SP_InHiLim 4.0 Upper limit of the internal setpoint
C SP_InLoLim 2.0 Lower limit of the internal setpoint
C PV_AH_Lim 4.5 Alarm upper limit for the process value
C PV_WH_LIM 4.0 Warning upper limit for the process value
C PV_WL_Lim 2.0 Warning lower limit for the process value
C PV_AL_Lim 1.0 Alarm lower limit for the process value
C PV_Hyst 0.1 Hysteresis for the limit values

C

PV_AH_En
PV_WH_En
PV_WL_En
PV_AL_En

Activation of the alarm and warning limit
monitoring

C MV
Interconnection for the simulation
(Sim_Vapor\Lag_Vapor.In)

C PV_Out

Interconnection for
(Process\\Sim_ProcModel\V_MinusV0.In1)
(Distillation\\KPI\VaporDivDistFlow.In1)

to_Actor_Slave Out
Interconnection for the valve
(YC_Vapor\from_Ctrl.In)

from_Actor_Slave In
Interconnection for the valve
(YC_Vapor\to_Ctrl.Out)

to_Master Out
Interconnection for the master controller
(TIC_DistBottom\from_Ctrl_2.In)

from_Master In
Interconnection for the master controller
(TIC_DistBottom\to_Ctrl_2.Out)

PV SimPV_In

Interconnection for the simulated process
value
(Sim_Vapor\Gain_Vapor.Out)

YC_Vapor
The instance has the following parameterization.
Table 3-10

Block Connection Value Use

from_Ctrl In
Interconnection for the controller
(FIC_ColuHead\to_Actor_Slave.Out)

to_Ctrl Out
Interconnection for the controller
(FIC_ColuHead\from_Actor_Slave.In)
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3.6 Capacitor with reflux "Reflux"

The temperature of the low boiler is reached by returning the condensate (head
product).

Structure
Flow control is performed by means of a standard PID controller and an external
setpoint from the multivariable controller "TIC_DistBottom". The following table
gives you an overview of the CM and the selected variants.

Table 3-11

CM CMT Variant Description

FIC_Reflux "Ctrl" Ctrl_Std
Activated option "Opt_IF_Master"

Concensate flow control

YC_Reflux "ValAn" ValAn_Std Control valve for condensate reflux
to the column

NS_PumpReflux "Mot" Mot_Std Pump (e.g. flow pump) for returning
the condensate to the column

In the following figure, the structure with the cross-chart interconnection is depicted
in simplified form.
Figure 3-9
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"Sim_Reflux" simulation
The condensate flow is simulated in the simulation chart.
Figure 3-10

1 2

1. Lag time of 2 seconds, which is caused by the inertia of the actuator as well as
by the time constant of the flow sensor.

2. The gain factor for the simulation of the process gain.
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Parameter assignment

FIC_Reflux
The instance has the following parameterization.
Table 3-12

Block Connection Value Use

PV_Scale HiScale 50 Process value upper limit
PV_Unit In 1352 Unit of the process value in L/h
C Gain 10 Controller gain
C TI 2.5 Controller lag
C SP_InHiLim 10.0 Upper limit of the internal setpoint
C SP_InLoLim 2.0 Lower limit of the internal setpoint
C PV_AH_Lim 20.0 Alarm upper limit for the process value
C PV_WH_LIM 18.0 Warning upper limit for the process value
C PV_WL_Lim 2.0 Warning lower limit for the process value
C PV_AL_Lim 0.0 Alarm lower limit for the process value
C PV_Hyst 0.5 Hysteresis for the limit values

C

PV_AH_En
PV_WH_En
PV_WL_En
PV_AL_En

Activation of the alarm and warning limit
monitoring

C MV
Interconnection for the simulation
(Sim_Reflux\Lag_Reflux.In)

C PV_Out

Interconnection for
(Process\\Sim_ProcModel\L_MinusL0.In1)
(Distillation\\KPI\RefluxDivDistFlow.In1)

to_Actor_Slave Out
Interconnection for the valve
(YC_Reflux\from_Ctrl.In)

from_Actor_Slave In
Interconnection for the valve
(YC_Reflux\to_Ctrl.Out)

to_Master Out
Interconnection for the master controller
(TIC_DistBottom\from_Ctrl_1.In)

from_Master In
Interconnection for the master controller
(TIC_DistBottom\to_Ctrl_1.Out)

PV SimPV_In

Interconnection for the simulated process
value
(Sim_Reflux\Gain_Reflux.Out)

YC_Reflux
The instance has the following parameterization.
Table 3-13

Block Connection Value Use

from_Ctrl In
Interconnection for the controller
(FIC_Reflux\to_Actor_Slave.Out)

to_Ctrl Out
Interconnection for the controller
(FIC_Reflux\from_Actor_Slave.In)

NS_PumpReflux
No parameter change with regard to the type.
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3.7 Removal of the head product "HeadLevel"

Condensate level control is performed via the upper product discharge and
is realized with the equipment module "Level-Control". The level simulation
is performed in the higher-level process simulation "Sim_ProcModel". The return
tank serves as a buffer, ensuring that the condensate return to the column is as
continuous as possible.

Structure
Level control is performed by means of a standard PID controller with a setpoint
value specification by the step sequencer. During process mode, the setpoint can
be set by the operator in the defined area.
The following table provides an overview of the CM and the selected variants.

Table 3-14

CM CMT Variant Description

LIC_RefluxDrum "Ctrl" Ctrl_Std Source "Level-Control" for level control
YC_RefluxDrum "ValAn" ValAn_Std Source "Level-Control” as a control valve for the

product discharge
NS_PumpDistil "Mot" Mot_Std Pump (e.g. flow pump) for removing the

condensate

Parameter assignment

LIC_RefluxDrum
The instance has the following parameterization.
Table 3-15

Block Connection Value Use

PV_Scale HiScale 100 Process value upper limit
PV_Unit In 1342 Process value unit in %
C Gain 1.0 Controller gain
C TI 1.0 Controller lag
C SP_InHiLim 100.0 Upper limit of the internal setpoint
C PV_AH_Lim 95.0 Alarm upper limit for the process value
C PV_WH_LIM 90.0 Warning upper limit for the process value
C PV_WL_Lim 10.0 Warning lower limit for the process value
C PV_AL_Lim 5.0 Alarm lower limit for the process value

C

PV_AH_En
PV_WH_En
PV_WL_En
PV_AL_En

Activation of the alarm and warning limit
monitoring

C MV

Interconnection for
(Process\\Sim_ProcModel\D_Norm.In1)
(Distillation\\KPI\ValveCharDist.In1)

to_Actor_Slave Out
Interconnection for the valve
(YC_RefluxDrum\from_Ctrl.In)

from_Actor_Slave In
Interconnection for the valve
(YC_RefluxDrum\to_Ctrl.Out)
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Block Connection Value Use

PV SimPV_In

Interconnection for the simulated process
value
(Process\\Sim_ProcModel\mD_Prozent.OUT)

YC_RefluxDrum
The instance has the following parameterization.
Table 3-16

Block Connection Value Use

from_Ctrl In
Interconnection for the controller
(LIC_RefluxDrum\to_Actor_Slave.Out)

to_Ctrl Out
Interconnection for the controller
(LIC_RefluxDrum\from_Actor_Slave.In)

NS_PumpDistil
No parameter change with regard to the type.



3 Structure and principle of operation
3.8 Removal of the bottom product "Bottom Level"

Distillation Column
Entry ID: 48418663,    V2.0,    10/2015 33

S
ie

m
en

s
A

G
20

15
A

ll
rig

ht
s

re
se

rv
ed

3.8 Removal of the bottom product "Bottom Level"

The level of the low boiler is controlled via the bottom product discharge and is
realized with the equipment module "Level-Control". The level in the column bottom
is performed in the higher-level process simulation "Sim_ProcModel".

Structure
Level control is performed by means of a standard PID controller with a setpoint
value specification by the step sequencer. During process mode, the setpoint can
be set by the operator in the defined area.
The following table provides an overview of the CM and the selected variants.

Table 3-17

CM CMT Variant Description

LIC_Bottom "Ctrl" Ctrl_Std Source "Level-Control" for level control
YC_Bottom "ValAn" ValAn_Std Source "Level-Control” as a control valve for the

product discharge
NS_PumpBottom "Mot" Mot_Std Pump (e.g. flow pump) for removing the low

boiler

Parameter assignment

LIC_Bottom
The instance has the following parameterization.
Table 3-18

Block Connection Value Use

PV_Scale HiScale 100 Process value upper limit
PV_Unit In 1342 Process value unit in %
C Gain 1.0 Controller gain
C TI 10.0 Controller lag
C SP_InHiLim 100.0 Upper limit of the internal setpoint
C PV_AH_Lim 85.0 Alarm upper limit for the process value
C PV_WH_LIM 80.0 Warning upper limit for the process value
C PV_WL_Lim 20.0 Warning lower limit for the process value
C PV_AL_Lim 15.0 Alarm lower limit for the process value

C

PV_AH_En
PV_WH_En
PV_WL_En
PV_AL_En

Activation of the alarm and warning limit
monitoring

C MV
Interconnection for the simulation chart
(Process\\Sim_ProcModel\B_Norm.In1)

to_Actor_Slave Out
Interconnection for the valve
(YC_Bottom\from_Ctrl.In)

from_Actor_Slave In
Interconnection for the valve
(YC_Bottom\to_Ctrl.Out)

PV SimPV_In

Interconnection for the simulated process
value
(Process\\Sim_ProcModel\mB_Prozent.OUT)



3 Structure and principle of operation
3.8 Removal of the bottom product "Bottom Level"

Distillation Column
Entry ID: 48418663,    V2.0,    10/2015 34

S
ie

m
en

s
A

G
20

15
A

ll
rig

ht
s

re
se

rv
ed

YC_Bottom
The instance has the following parameterization.
Table 3-19

Block Connection Value Use

from_Ctrl In
Interconnection for the controller
(LIC_Bottom\to_Actor_Slave.Out)

to_Ctrl Out
Interconnection for the controller
(LIC_Bottom\from_Actor_Slave.In)

NS_PumpBottom
No parameter change with regard to the type.
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3.9 Distillation

An optimum thermal separation is needed to produce high-quality low and high
boilers. For this reason, the different temperature ranges of the column are
recorded and monitored. A multivariable controller is used to complete the
separating task (production of distillate) with high quality results and to better
respond to disturbances.

Structure
The temperature is controlled as a cascade of multi-variable master controllers
"TIC_DistBottom" and the slave controllers "FIC_Reflux" and "FIC_Vapor".
The multivariable controller also monitors the mixture feed as a disturbance.
The following table provides an overview of the CM and the selected variants.

Table 3-20

CM CMT Variant Description

TIC_DistBottom "CtrlMPC" Ctrl_Std Multivariable controller as a master controller
TI_HeadPacking "AMon" AMon_Std

activated option
"Opt_IF_MPC"

Measuring point for displaying the upper
separating temperature

TI_BottomPacking "AMon" AMon_Std
activated option
"Opt_IF_MPC"

Measuring point for displaying the lower
separating temperature

In the following figure, the structure with the cross-chart interconnection is depicted
in simplified form.

Figure 3-11
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Parameter assignment

TIC_DistBottom
The instance is configured by activating the options "Opt_CPM_1" and
"Opt_CPM_2" for two control variables. The instance has the following
parameterization.
Table 3-21

Block Connection Value Use

MPC DV1

Interconnection for the controller that
is detected as a disturbance
(Feed\\FIC_Feed\C.PV_Out)

MPC DB 40
Data block with the recorded process
behavior (process model)

from_CV1 In
Interconnection for the control variable
(TI_HeadPacking\to_MPC.Out)

from_CV2 In
Interconnection for the control variable
(TI_BottomPacking\to_MPC.Out)

from_Ctrl1 In
Interconnection for the slave controller
(FIC_Reflux\to_Master.Out)

to_Ctrl1 Out
Interconnection for the slave controller
(FIC_Reflux\from_Master.In)

from_Ctrl2 In
Interconnection for the slave controller
(FIC_Vapor\to_Master.Out)

to_Ctrl2 Out
Interconnection for the slave controller
(FIC_Vapor\from_Master.In)

Note The blocks for control quality monitoring and system deviation form part of the
CFC. The respective block icons for display of information are not part of the
process screens. If necessary, the "Create block icon" function can be activated
in the block properties. The respective block icons are available in the process
screen once the OS is compiled.
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TI_BottomPacking
The instance is configured by activating the "Opt_IF_MPC" option for connection
to the multivariable controller as a control variable. The instance has the following
parameterization.
Table 3-22

Block Connection Value Use

PV_Unit In 1001 Process value unit in °C
I PV_Hyst 0.3 Hysteresis for the limit values
I PV_AH_Lim 83.0 Alarm upper limit for the process value
I PV_WH_LIM 83.0 Warning upper limit for the process value
I PV_WL_Lim 71.0 Warning lower limit for the process value
I PV_AL_Lim 71.0 Alarm lower limit for the process value

I

PV_AH_En
PV_WH_En
PV_WL_En
PV_AL_En

Activation of the alarm and warning limit
monitoring

to_MPC Out

Interconnection for the multivariable
controller
(TIC_DistBottom\from_CV2.In)

PV_In SimPV_In
Interconnection for the simulation:
(Process\\Sim_TempNorm\T_B_Celsius.Out)

TI_HeadPacking
The instance is configured by activating the"Opt_IF_MPC" option for connection
to the multivariable controller as a control variable. The instance has the following
parameterization.
Table 3-23

Block Connection Value Use

PV_Unit In 1001 Process value unit in °C
I PV_Hyst 0.3 Hysteresis for the limit values
I PV_AH_Lim 73.0 Alarm upper limit for the process value
I PV_WH_LIM 72.0 Warning upper limit for the process value
I PV_WL_Lim 69.0 Warning lower limit for the process value
I PV_AL_Lim 68.0 Alarm lower limit for the process value

I

PV_AH_En
PV_WH_En
PV_WL_En
PV_AL_En

Activation of the alarm and warning limit
monitoring

to_MPC Out

Interconnection for the multivariable
controller
(TIC_DistBottom\from_CV1.In)

PV_In SimPV_In
Interconnection for the simulation:
(Process\\Sim_TempNorm\T_D_Celsius.Out)
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3.10 Process simulation (Process)

The timing of the simulation model of the distillation column is shortened many
times over in comparison to a real installation to obtain a faster reaction ("time-
lapse").
The simulation included in the "Process" folder consists of the following parts:
 Simulation of the process (CFC "Sim_ProcModel")
 Conversion of temperature values (CFC "Sim_TempNorm")
 Integration limit (CFC "Sim_AntiWindUp")

The following CMs are also included in the "Process" folder for measured value
display:
 "PI_ColuBottom": Pressure at the column bottom
 "TI_Head": Temperature at the column head
 "TI_AboveFeed": Temperature above the mixture feed
 "TI_BelowFeed": Temperature below the mixture feed
 "TI_Bottom": "Temperature at the column bottom

Process simulation
The CFC "Sim_ProcModel" contains all of those parts of the simulation model that
not only describe an individual system section but also have an overarching nature.
The role of process simulation is to understand the functioning of the distillation
column, particularly in relation to the control functions of the multivariable controller
or to be able to demonstrate it. It does not claim to replicate exactly the real
physical behavior of a particular distillation column.
The process model is a 6x4 multivariable system that simulates all the influencing
input-output combinations in separate partial transfer functions. The simulation is
designed on the operating point of the process.
The following figure shows the process model with the corresponding names:

Figure 3-12

u1 u2 u3 u4 u5 u6
y1 G1.1 G1.2 G1.3 G1.4 G1.5 G1.6

y2 G2.1 G2.2 G2.3 G2.4 G2.5 G2.6

y3 G3.1 G3.2 G3.3 G3.4 G3.5 G3.6

y4 G4.1 G4.2 G4.3 G4.4 G4.5 G4.6

Reflux Vapor Distill. Flow Bottom Flow Flow Inlet Concentr. Inlet
L V D B F zF

xD y1u1 y1u2 y1u3 y1u4 y1u5 y1u6
xB y2u1 y2u2 y2u3 y2u4 y2u5 y2u6
mD y3u1 y3u2 y3u3 --- --- ---
mB y4u1 y4u2 --- y4u4 y4u5 ---

Level Distillation
Level Bottom

General model

Derived Process Model (with name in CFC)

Inputs

O
ut

pu
ts

Concentr.Distillation
Concentr.Bottom

The process model is divided into two chart partitions in the CFC
"Sim_ProcModel".
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Chart partition A
The chart partition "A" includes transfer functions of an input signal which affect the
defined output signals (Figure 3-12). All partial transfer functions have the same
general structure and are reduced to the essential.
The following figure shows the sheet 1, which includes the effects of the "Reflux"
input signal (L) on all outputs.

Figure 3-13

1

2 3

6

3

4

5

A partial transfer function may contain up to five components, as can be seen in
the following examples:
 Partial transfer function with PT behavior "y1u1" with the components 1, 2, 3
 Partial transfer function with IT behavior "y4u1" with the components 1, 3, 4,

5, 6

1. Deviation from operating point: This block allows for the operating point of
the input to be indicated and the difference to it to be calculated. If necessary,
some input values can be normalized in advance.

2. Dead time: Gives the dead time of the partial transfer function.
3. PT transfer function (Chart-in-Chart): Three delay elements and

a reinforcing member are switched in succession in the transfer function.
Furthermore, noise can be added to the output signal.

4. Sign: Determination of the sign for integration.
5. Limitation of integration ("SimAntiWindUp" as Chart-in-Chart): The input

signal for the integrator is pre-checked for overranged and underranged limits
and the integration of the output value is stopped (output signal).

6. Integrator: The integrators are used for level simulation.
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Chart partition B
In chart partition "B", the output signals are calculated from all intermediate values
of the individual inputs. To do this, all the influences of all inputs are added and the
total is limited to defined limits. The calculated level values are also converted to
percent.

Conversion of temperature values
In the CFC "Sim_TempNorm", the normalized temperatures of "TI_HeadPacking"
and "TI_BottomPacking", which are used in the simulation model, are converted
into degrees Celsius. The temperature values above (1) and below (2) the mixture-
addition are output with 5 °C difference from the converted temperatures
"TI_HeadPacking" and "TI_BottomPacking".

Figure 3-14

1

2

The remaining process values for head temperature, bottom temperature and
bottom pressure are fixed and issued with a process noise.
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Integration limit
The CFC "Sim_AntiWindUp" is carried out using the Chart-in-Chart technique and
serves as an integration limit for integral transfer functions of the process model.
The following figure shows the structure of CFC.

Figure 3-15

Parameter assignment

TI_AboveFeed
The instance is used as a variant "AMon_Std" and has the following
parameterization.
Table 3-24

Block Connection Value Use

PV_Unit In 1001 Process value unit in °C
I PV_Hyst 0.3 Hysteresis for the limit values
I PV_AH_Lim 82.0 Alarm upper limit for the process value
I PV_WH_LIM 81.0 Warning upper limit for the process value
I PV_WL_Lim 69.0 Warning lower limit for the process value
I PV_AL_Lim 69.0 Alarm lower limit for the process value

I

PV_AH_En
PV_WH_En
PV_WL_En
PV_AL_En

Activation of the alarm and warning limit
monitoring

PV_In SimPV_In
Interconnection for the simulation:
(Process\\Sim_TempNorm\T_AboveFeed.Out)
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TI_BelowFeed
The instance is used as a variant "AMon_Std" and has the following
parameterization.
Table 3-25

Block Connection Value Use

PV_Unit In 1001 Process value unit in °C
I PV_Hyst 0.3 Hysteresis for the limit values
I PV_AH_Lim 83.0 Alarm upper limit for the process value
I PV_WH_LIM 83.0 Warning upper limit for the process value
I PV_WL_Lim 71.0 Warning lower limit for the process value
I PV_AL_Lim 71.0 Alarm lower limit for the process value

I

PV_AH_En
PV_WH_En
PV_WL_En
PV_AL_En

Activation of the alarm and warning limit
monitoring

PV_In SimPV_In
Interconnection for the simulation:
(Process\\Sim_TempNorm\T_BelowFeed.Out)

TI_Bottom
The instance is used as a variant "AMon_Std" and has the following
parameterization.
Table 3-26

Block Connection Value Use

PV_Unit In 1001 Process value unit in °C
I PV_Hyst 0.3 Hysteresis for the limit values
I PV_AH_Lim 83.0 Alarm upper limit for the process value
I PV_WH_LIM 83.0 Warning upper limit for the process value
I PV_WL_Lim 71.0 Warning lower limit for the process value
I PV_AL_Lim 71.0 Alarm lower limit for the process value

I

PV_AH_En
PV_WH_En
PV_WL_En
PV_AL_En

Activation of the alarm and warning limit
monitoring

PV_In SimPV_In
Interconnection for the simulation:
(Process\\Sim_TempNorm\T_Bottom.Out)
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TI_Head
The instance is used as a variant "AMon_Std" and has the following
parameterization.
Table 3-27

Block Connection Value Use

PV_Unit In 1001 Process value unit in °C
I PV_Hyst 0.3 Hysteresis for the limit values
I PV_AH_Lim 82.0 Alarm upper limit for the process value
I PV_WH_LIM 81.0 Warning upper limit for the process value
I PV_WL_Lim 69.0 Warning lower limit for the process value
I PV_AL_Lim 69.0 Alarm lower limit for the process value

I

PV_AH_En
PV_WH_En
PV_WL_En
PV_AL_En

Activation of the alarm and warning limit
monitoring

PV_In SimPV_In
Interconnection for the simulation:
(Process\\Sim_TempNorm\T_Head.Out)

PI_ColuBottom
The instance is used as a variant "AMon_Std" and has the following
parameterization.
Table 3-28

Block Connection Value Use

PV_Unit In 1137 Process value unit in bar
I PV_Hyst 0.01 Hysteresis for the limit values
I PV_AH_Lim 1.9 Alarm upper limit for the process value
I PV_WH_LIM 1.8 Warning upper limit for the process value
I PV_WL_Lim 0.2 Warning lower limit for the process value
I PV_AL_Lim 0.1 Alarm lower limit for the process value

I

PV_AH_En
PV_WH_En
PV_WL_En
PV_AL_En

Activation of the alarm and warning limit
monitoring

PV_In SimPV_In
Interconnection for the simulation:
(Process\\Sim_TempNorm\P_ColuBottom.Out)
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3.11 Sequencers

Different behavior and modes of operation can be realized in SFC. In the sample
project the SFC "StartDistColumn" is configured for automatic start-up without user
interaction. After start-up, the controller is transferred to the user in automatic
mode, allowing him to determine, for instance, the individual setpoint values.
The following actions are configured in the SFC:
 Resetting the simulation
 Initializing the default controller
 Presetting the working ranges (setpoints)
 Operating mode of the pumps to Automatic
 Initializing the multivariable controller
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3.12 Process parameters "KPI"

The CFC comprises key performance indicators that inform the operator about the
process performance. The following key performance indicators are calculated and
shown in the visualization:
1. Production volume of the head product:

Manipulated variable for the level control of the condensate * factor 0.2

2. Production volume of the bottom product:
Inflow of the input material – production volume of the head product

3. Pressure loss in the column:
Bottom pressure – pressure at column head

4. Reflux ratio:
Reflux / production volume of head product

5. Relative energy consumption;
Vapor amount / production volume of head product

You can also find the operator control block "FeedComposition" on sheet 3. This
allows the composition of the input material or the separation ratio to be defined.

3.13 Maintenance

In the CFC "Maintenance", the operation time of the column and the pressure loss
in the column are continuously monitored with the block "AssetM" and an alarm
message is thrown if levels are exceeded.

Note The block icon for displaying the maintenance information does not form part
of the process screens. If necessary, the "Create block icon" function can be
activated in the block properties. The block icon is available in the process
screen once the OS is compiled.
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3.14 Task-related overview screens with APG

With PCS 7 Advanced Process Graphics, process screens are displayed more
clearly, reduced to the essential and are intuitive to use. The focus lies in the
consideration of the relevant process variables within the working ranges. In this
example, the plant overview screen and the process screen are created with APG.

3.14.1 Integration of APG

The integration of APG is configured in two phases:
1. Insertion and parameter assignment of APG blocks in the measuring points

(AS)
2. Placement and interconnection of APG objects (OS)

Note You can find basic information about APG, for extension of an existing PCS 7
project with APG and for configuration purposes in the application description
"Integration of Advanced Process Graphics in SIMATIC PCS 7" under the entry
ID: 89332241.

3.14.2 APG measuring points (AS)

In the CMT "Ctrl" and "AMon", the APG connector block has been added in chart
partition "A" "Sheet 4" and linked to the controller or display block. The extended
CMTs of the master data library are synchronized with the automation project.

Note The Application Example "Control Module (CM) Technology - Efficient
Engineering with SIMATIC PCS 7" with the entry ID: 109475748 describes how
efficiently an existing project is extended to APG by applying the control module
technology.

Controller measuring points
The CMT "Ctrl" contains the following parameterization.
Table 3-29

Connection Value Use

BockType 2 Representation suitable for the "PIDConL" block
ViewMode 1 Absolute representation (value range)
ViewRange 4 Display of the working range
ReadPointer Connected with "C.Status2"

https://support.industry.siemens.com/cs/ww/en/view/89332241
https://support.industry.siemens.com/cs/ww/en/view/109475748
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The following table contains the parameterization of all instances in which the
"HMI" option has been activated.
Table 3-30

CM Connection Value Use

LIC_Bottom PV_Ox_Li No change with regard to the type
FIC_Feed PV_OH_Li 30.0 Upper limit of the working range
FIC_Feed PV_OL_Li 0.0 Lower limit of the working range
FIC_RefluxDrum DispRatio 0.5 Display ratio
FIC_Vapor PV_OH_Li 10.0 Upper limit of the working range
FIC_Vapor PV_OL_Li 0.0 Lower limit of the working range
PIC_ColuHead PV_OH_Li 2.0 Upper limit of the working range
PIC_ColuHead PV_OL_Li 0.0 Lower limit of the working range
FIC_Reflux PV_OH_Li 50.0 Upper limit of the working range
FIC_Reflux PV_OL_Li 0.0 Lower limit of the working range

Display measuring points
The CMT "AMon" contains the following parameterization.
Table 3-31

Block Connection Value Use

HMI BockType 1
Representation suitable for the "PIDConL"
block

HMI ViewMode 1 Absolute representation (value range)
HMI ViewRange 4 Display of the working range
HMI ReadPointer Connected with "C.Status2"

The following table contains the parameterization of all instances in which the
"HMI" option has been activated.
Table 3-32

CM Connection Value Use

TI_HeadPacking ViewMode 2 Difference representation
TI_BottomPacking ViewMode 2 Difference representation
TI_AboveFeed ViewMode 2 Difference representation
TI_BelowFeed ViewMode 2 Difference representation
TI_Bottom ViewMode 2 Difference representation
TI_Head ViewMode 2 Difference representation
PI_ColuBottom PV_OH_Li 10.0 Upper limit of the working range
PI_ColuBottom PV_OL_Li 0.0 Lower limit of the working range
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KPI measuring point
The CFC "KPI" contains five instances of the APG connector blocks. The
interconnection and parameters of "BlockType", "ViewMode" and "ViewRange"
correspond to the parameterization of the display measuring point. The following
table contains the parameterization of the display areas.
Table 3-33

Block Connection Value Use

HMI_FI_DistProd PX_OH_Li 20.0 Upper limit of the working range
HMI_FI_DistProd PX_OL_Li 0.0 Lower limit of the working range
HMI_FI_BottoProd PX_OH_Li 20.0 Upper limit of the working range
HMI_FI_BottoProd PX_OL_Li 0.0 Lower limit of the working range
HMI_PressureLost PV_OH_Li 0.5 Upper limit of the working range
HMI_PressureLost PX_OL_Li 0.0 Lower limit of the working range
HMI_RefluxRatio PV_OH_Li 10.0 Upper limit of the working range
HMI_RefluxRatio PX_OL_Li 0.0 Lower limit of the working range
HMI_EnergyConsum PV_OH_Li 3.0 Upper limit of the working range
HMI_EnergyConsum PX_OL_Li 0.0 Lower limit of the working range
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4 Starting the Unit Template
4.1 Preparation

The following instructions describe putting the Unit template into service by
simulating the controller with the "S7-PLCSIM" program. If there is a real controller,
you must configure existing hardware components in the HW Config.
1. Copy the file "48418663_DistillColumn_PROJ_PCS7V811.zip" into any folder

on the configuration PC and then open the SIMATIC Manager.
2. In the menu bar, click on "File > Retrieve" and select the file

"48418663_DistillColumn_PROJ_PCS7V811.zip". Then confirm with "Open".
3. Select the folder in which the project should be saved and confirm by pressing

"OK".
The project will be retrieved.

4. Confirm the "Retrieve" dialog with the "OK" button and then click on "Yes" in
the dialog to open the project.

5. Right-click on "ChColumn_OS_Prj > PCS7VM > WinCC Appl. > OS" and then
click on the menu command "Open object".

6. Confirm the "Configured server not available" dialog with "OK".
7. In the WinCC Explorer, open the characteristics of your computer and, in the

opened Properties dialog, click on the "Use local computer name" button.

8. Confirm the "Change computer name" message with "OK".
9. In the WinCC Explorer, click on "File > End" and, in the subsequent dialog,

select "Terminate WinCC Explorer and close project".
10. Then confirm with OK.
11. Reopen the WinCC Explorer as described in step 5.
12. Open by double-clicking on "Variables library".
13. In the "WinCC Configuration Studio", open "Variables library > SIMATIC S7

Protocol Suite > TCP/IP" and select the menu command "System parameters".
14. In the "Unit" tab, check the "Logical device names" setting. If the "S7 PLCSIM"

program is used, the device name "PLCSIM.TCPIP.12" is selected.
A restart is required after a device name change.

Note If the OS cannot establish a connection with the AS (grayed out block icons),
select the logical device name "CP_H1_1" and restart the OS runtime.
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4.2 Commissioning

The following instructions show how the Unit Template is initialized. The project
contains an SFC chart where all the important settings are configured so that die
system reaches the operating point.
To put into service, it is required that SIMATIC Manager is already open and that
the Unit Template has been selected in the component view.

Starting the simulation (S7 PLCSIM)
To start the simulation, proceed according to the following instructions:
1. Select "Extras > Simulate Modules" from the menu.

The "S7-PLCSIM" dialog window opens.
2. In the "Open project" dialog, select "Open project from file".
3. Select the file "ChColumn.plc" from the path

<Projektpfad>\ChColumn\ChCo_AS\ChColumn.plc>.
4. In the menu, select "Execute > Key-switch position > RUN-P".
5. Switch to the component view of the SIMATIC Manager and mark

"ChColumn_AS_Prj > AS01".
6. In the menu bar, click on "Target system > Load" and confirm the "Load" dialog

with "Yes".
7. Confirm the "Stop target group" dialog with "OK" and the subsequent "Load"

dialog with "Yes".

Activate OS (WinCC runtime)
To activate the OS, proceed according to the following instructions:
1. Right-click on the OS and select the menu "Open Object".
2. To activate the OS (WinCC Runtime), select the menu command "File >

Activate" in WinCC Explorer.
3. In the "System Login" dialog, enter as "Login" the user "Unit" and "Template"

as the password; confirm with "OK".
4. Select "DistillationGroup" in the icon area.
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5 Running the Application
5.1 Overview

All components of the distillation column can be controlled and monitored from the
process screen. In addition, the plant operator receives information (KPI's) for the
current process.

Note Please note that it takes about 6 minutes for the column to reach the operating
point after the program starts (PLCSIM). During operational production, all
controllers are enabled for setpoint changes except the cascade controllers.

The following two scenarios are limited to the two variables that are significantly
relevant for the operation of a distillation column and which demonstrate the mode
of operation of the multivariable controller in compensating for interferences.
 Changing the feed amount
 Changing the feed concentration

When the distillation column is in a steady state, the feed amount and the feed
concentration determine the amount that can be delivered by the head or bottom
product. A variable, which acts as a disturbance for the controller, is modified in
each of the two scenarios.

Note The signal noise for the two control variables has been disabled for trend
recording and evaluation.

5.2 Scenario A - Changing the feed amount

In this scenario, the concentration of low boilers in the mixture feed is constant and
the feed amount is increased from 20 L/min to 23 L/min (+15%). The feed amount
is detected by the controller as a disturbance (DV1 input) and the effect of the
disturbance is reflected in the process model.
1. Switch to the Detail view of the distillation column.
2. Click on the block icon of "TIC_DistBottom" block and click on the trend icon

in the menu bar of the faceplate.
3. Click on the block icon for the "FIC_Feed" to also open its faceplate. Arrange

the picture windows in a clear way.

1

2

2

1
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4. Click on the input field "Setpoint" in the "FIC_Feed" block and enter the
value "23" in the text box of the extension. Then confirm the entry with the
Enter key and click the "OK" button.
The setpoint for the feed is accepted and the multivariable controller starts
compensating the detected disturbance.

5. Wait about 3 minutes and click on the "Start/Stop" symbol to evaluate the
control result.

Evaluation
The screenshot gives you the trend curves of the multivariable controller.

Approx. -0.08°C

Approx. +0.1°C

Head control temperature

Bottom control temperature

Even a slight deviation of about 0.1 °C gives a good control result, which can be
explained by the fact that the disturbance has been detected and that the controller
knows the influence of the disturbance. The controller can thus respond
immediately to the change of the disturbance with the necessary procedures
and does not have to wait for changes in the control variables.
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5.3 Scenario B - Changing the feed concentration

When the distillation column is in a steady state, the feed amount and the feed
concentration determine the amount that can be delivered by the head or bottom
product. In this scenario, the inflow amount remains constant and the concentration
of low boiler in the feed mixture is lowered from 0.5 to 0.4 (-20%).
The concentration of low boiler in the feed mixture is an unknown disturbance for
the controller, which is not recognized according to a model.
1. Click on the block icon of "ModelPredictCont" and click on the trend icon in the

menu bar of the faceplate.
2. Click on the block icon for the "FeedComposition" to also open its faceplate.

Arrange the picture windows in a clear way.

1 2

2

1

3. Click on the input field "Setpoint" in the faceplate of "FeedComposition" and
enter
the value "0.4" in the text box of the extension. Then confirm the entry with
"ENTER" and click the "OK" button.
The setpoint for the concentration of low boiler in the fed mixture is applied
and the multivariable controller starts compensating the disturbance.

4. Wait about 3 minutes and click on the "Start/Stop" symbol to evaluate the
control result.
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Evaluation
The screenshot gives you the trend curves of the multivariable controller.

Approx. +0.4°C

Head control temperature

Bottom control temperature

Approx. +0.5°C

Even a slight deviation of about 0.5 °C gives a good control result, since the size
and effect of the disturbance variable are unknown to the controller and the
controller can only react to the change of control variables.
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6 Further Notes, Tips and Tricks, Etc.
6.1 Configuration of the PID controller

The program "PID Tuner" is available for the configuration of the PID controller.
This program determines the optimum PID parameters for the connected controlled
system. The following instructions describe the general procedure using the
example of the PID controller in the CFC "FIC_Feed".

Note The document "PID Control with Gain Scheduling and PID Tuning" gives you
a practical controlling example.

Requirements
 The controller is connected to the process or to the simulation.
 The control program is compiled and loaded.

CAUTION The optimization results in an intervention in the system process. You should
be aware of the implications this may have.

To obtain an optimal result, carry out the controller optimization between the
minimum and maximum working range of the corresponding variable (for
FIC_Feed: 15-25).

During optimization, observe the process constantly from the curve recorder.

Granting optimization release
The program "PID Tuner" runs on the engineering station (ES). Since the operator
control and monitoring station (OS) and the ES do not generally run on it the same
computer, PCS 7 offers the coordination of users function. The release takes place
in the operating screen of the controller (View > Parameters). With this release,
you grant the engineering system (PID Tuner) the right to intervene actively in
the process. The respective possible operations on the OS are blocked during
optimization.
To use the program "PID Tuner", the value "1" must be present at the "OptimEn"
input of the "PIDConL" block. If you want to set this input in the ES, follow the
steps 1 to 5. If the release on the OS was granted, start with step 1 in the section
"Performing controller optimization".
1. Open the PCS 7 project in the plant view.
2. Open the folder hierarchy "Ch Column_AS_Prj > ChColumn >

DistillationGroup> Distillation > Feed" and double-click the chart "FIC_Feed".
The CFC editor is opened.

3. In the menu bar of the CFC Editor, click on "Test > Test mode" and confirm the
"Log in CPU for testing" dialog with "Yes".

4. Double-click the block "C" in sheet 1 of the CFC and click on the "Connections"
tab.

5. Change the value of the connection "OptimEn" to the value "1" and confirm
with "OK". Then close the block.

https://support.industry.siemens.com/cs/ww/en/view/38755162
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Carrying out the controller optimization
The following instructions describe controller optimization for a control system with
PT behavior.
1. Click on "Edit > Optimize PID controller..." in the menu bar of the CFC editor.

The PID Tuner opens.
2. Click the "stop" button under the curve recorder to stop the recording and then

click the "Settings" button.

3. Insert appropriate Y axis limits for the 3 curves (setpoint, actual value,
manipulated variable).

4. Adapt the "Acquisition cycle" and the "Timeline length" to the expected process
behavior and confirm your entries with "OK".

Note For detailed information on controller optimization, refer to the online help.
To open the online help, click the "Help" button in the lower part of the PID
Tuner.

5. Click on the "Start Controller Optimization" button in the lower part of the PID
Tuner.

6. In Step 1, select the check box "without integral component in the process
from" and click "Next".

7. In the group "Operating mode" select the check box "Automatic". Enter the
typical operating point (e.g. 20 L/min) of the control variable. Please observe
the warning in the lower part of the dialog and then click "Next".

8. As a "Step excitation, new setpoint:" enter a setpoint (e.g. 25 L/min.) well
above the typical operating point. Please observe the warning in the lower
part of the dialog and then click "Next".
The controller optimization has now been completed.

9. After completion of the optimization, select the check box "Withdraw" in the
"Processes excitation" group. Please observe the warning in the lower part
of the dialog and then click "Next".
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10. In group "Controller design to", select the check box "Optimal control behavior"
and click "Next".
An additional window will open with the identification result.

11. In the "Controller parameters" group, select the check box of the PI controller
and click "Next".

12. In step 8: "Simulate a control loop with the optimized parameters" click "Next".
Click the "New" button to implement the determined values.
Heed the warning in the lower part of the dialog and then click "Finish" to complete
the optimization.

6.2 Configuration of the MPC controller

Step responses form the basis for the controller design. These are incorporated in
the manual mode of the controller and recorded in trend curves. The trend curves
show all excited manipulated variables and all control variables. The excitation of
the manipulated variables begins at the operating point and contains a step to the
upper limit and to the lower limit (linearization in the working point) of the typical
position value for the operation of the plant. Each change in the manipulated
variable is only carried out when the system has reached a steady state.
The same procedure can be used for measurable disturbance variables.
These can be considered in the controller design.
Trend curves can be additionally evaluated for checking (verification) the controller
design.
The required trend curves can be created and exported in the CFC trend display.
For more information, see the "Help" section of the MPC configurator under
"Details on the individual design steps > Recording of measurement series".

Note You can find a detailed description in Application Example "Model Predictive
Control including integral transfer functions".

CAUTION In process interventions are necessary to configure the MPC controller!

Before the process intervention, check what implications it will have and inform
the appropriate personnel.

https://support.industry.siemens.com/cs/ww/en/view/42200753
https://support.industry.siemens.com/cs/ww/en/view/42200753
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Trend recording
1. Open the PCS 7 project in the plant view.
2. Open the folder hierarchy "ChColumn_AS_Prj > ChColumn > DistillationGroup

> Distillation > Distillation" and double-click the chart "TIC_DistBottom".
The CFC editor is opened.

3. Open the trend display from the menu "Display > Trend display".
4. Drag all relevant process values to the trend and set the upper and lower limits

for each value.

5. Register the CPU in test mode.
6. In the excitation block "AutoExcitation", enter the parameters "StepSize",

"Duration" (duration of excitation) and the number of manipulated variables
(interconnected controllers with MPC).

7. In the process screen (OS) of the distillation column, change the mode of the
multivariable controller "TIC_DistBottom" to Manual.

8. Switch back to the CFC and start the trend recording using the "Start" button.
9. Wait about 40 seconds until the first values (no steps) are recorded.
10. In the excitation block, start the process excitation with the value "1" at the

connection "StartExcite" and wait until all the excitation processes are
completed.
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11. Export the trend recording after completion of excitation.
12. Switch to the process process screen (OS) of the distillation column and

change the mode of the multivariable controller "TIC_DistBottom" to Auto.

Process identification
1. Open the PCS 7 project in the plant view.
2. Open the folder hierarchy "ChColumn_AS_Prj > ChColumn > DistillationGroup

> Distillation > Distillation" and double-click the chart "TIC_DistBottom".
The CFC editor is opened.

3. Select the block "MPC" and click in the menu bar "Edit > Configure MPC".
The MCP Configurator opens.

4. Click the button "Load data" and select the file containing the exported trend
curves. Confirm your selection with "OK".
The selected trend curves are uploaded to the group "Raw data".

Note In the project path "<Projekt path>\ChColumn" you can find the exported trend
log "DistillationColumn_20150923.csv".

5. In the drop-down lists to the right of the trend displays, select the displayed
signal and press the "Step by Step" button.

6. Determine the period for authentication, select the check box "Process with
dead times" and then click the "Identify" button.

7. In the "Controller parameters" group, enter the controller cycle time (the OB
cycle time in which the controller is called) and the DB number for the process
model.
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8.  Then click the "Design controller" button. This opens the "MPC – verification
and simulation" dialog.

Note The quality of the trend curves is displayed in the upper left corner of the dialog
"MPC process model". The quality should be above 50% for a controller design.

9. Click the "Load data" button in the group "Verification of the process model"
and select the file with the verification data in the file selection dialog.

10. The verification is started and the quality of the process model is shown.
11.  Click on the "Simulate control loop" button to check the value range.
12. The result between button and trend display is subsequently rated and can

also be viewed by clicking the trend display.
13. Click on the "Export SCL code" button and select the folder where to save

the SCL source file in the file selection dialog that follows.
14. Enter a name for the file and click "Save".
15. Confirm the message with "OK" and then close all dialog boxes of the MPC

configurator and the CFC.
16. Save the session log of the MPC configurator by right-clicking on the user

interface background.
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Generating a data block from the process model
1. Switch to the component view of the project.
2. Right click on „ChColumn_AS_Prj > AS01 > CPU 410-5H > AS01 > Sources“

and in the menu item choose "Insert new object > External source...".

Note In the project path "<Project path>\ChColumn", you can find the exported SCL
source file "ChColumn2015-09-23_MPC_DB41.scl".

3. Select the previously created SCL source file and click "Open."
This imports the SCL source file.

4. Double-click the SCL source file and click on the menu bar "File > Compile"
in the open SCL editor. Then close the SCL editor.

Note In the first line of the source code you will see the currently applied DB number
of the block. In order not to overwrite the available one, this should be changed
to the value 41

CAUTION If a data block already exists with that DB number, you will receive a message
asking if you want to overwrite the data block. Data blocks should only be
overwritten if you know their exact function. If in doubt, interrupt the compiling
process and change the DB number of the first line to a non-allocated DB
number.

The MPC function block must be invoked at the appropriate watchdog interrupt
OB. The cycle time of the OB and the specified time "OB-Timing" in the head
of the SCL source must be identical.
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5. Right-click on "ChColumn_AS_Prj > AS01 > CPU 410-5 > AS01 > Charts" and
double-click the chart "TIC_DistBottom", which contains the MPC controller.

6. Select the input "DB_No" and change the value to the number of the previously
generated data block.

Note The process model is updated the next time the control is compiled and
uploaded.

If the control program has already been uploaded, the DB number can also be
changed online. In order to do this, the DB must be uploaded to the controller
and the "Restart" input set online to "Reset". Steps may occur in the manipulated
variable after restarting the controller.
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7 Related Literature

Table 7-1

Topic Link

\1\ Siemens Industry Online Support http://support.industry.siemens.com

\2\ Download page of this entry https://support.industry.siemens.com/cs/ww/en
/view/48418663

\3\ SIMATIC PCS 7 Overview https://support.industry.siemens.com/cs/ww/en
/view/63481413

\4\ Model Predictive Control including
integral transfer functions

https://support.industry.siemens.com/cs/ww/en
/view/42200753

\5\ How do you do perform controller
optimization with the PCS 7 PID tuner?

https://support.industry.siemens.com/cs/ww/en
/view/8031495

\6\ Integration of Advanced Process
Graphics in SIMATIC PCS 7

https://support.industry.siemens.com/cs/ww/en
/view/89332241

\7\ Equipment Modules for PCS 7 using the
example of the Chemical Industry

https://support.industry.siemens.com/cs/ww/en
/view/53843373

\8\ PCS 7 Unit Template "Stirred Tank
Reactor" using the example of the
Chemical Industry

https://support.industry.siemens.com/cs/ww/en
/view/60546560

\9\ PCS 7 Unit Template "Fermenter" using
the example of the Chemical Industry

https://support.industry.siemens.com/cs/ww/en
/view/68098270

\10\ PCS 7 Unit Template "Dryer" using the
example of the Chemical Industry

https://support.industry.siemens.com/cs/ww/en
/view/74747848

\11\ PCS 7 Unit Template "Polymerization
Reactor" using the example of the
Chemical Industry

https://support.industry.siemens.com/cs/ww/en
/view/84061788

\12\ How do you procure documentation for
PCS 7 (including the PCS 7 Manual
Collection)?

https://support.industry.siemens.com/cs/ww/en
/view/59538371
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